## Typographic Conventions

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options. Textual cross-references to other documents.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><code>&lt;Example&gt;</code></td>
<td>Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Keys on the keyboard, for example, F2 or ENTER.</td>
</tr>
</tbody>
</table>
## Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2013-03-18</td>
<td>Initial Version</td>
</tr>
<tr>
<td>1.1</td>
<td>2013-08-23</td>
<td>Updates to reflect SAP Landscape Transformation Replication Server DMIS_2011 support package 05</td>
</tr>
<tr>
<td>1.2</td>
<td>2014-01-29</td>
<td>Updates to reflect SAP Landscape Transformation Replication Server DMIS_2011 support package 06</td>
</tr>
<tr>
<td>1.3</td>
<td>2014-07-08</td>
<td>Updates to reflect SAP Landscape Transformation Replication Server DMIS_2011 support package 07</td>
</tr>
<tr>
<td>1.4</td>
<td>2015-01-21</td>
<td>Updates to reflect SAP Landscape Transformation Replication Server DMIS_2011 support package 08</td>
</tr>
<tr>
<td>1.5</td>
<td>2015-07-28</td>
<td>Updates to reflect SAP Landscape Transformation Replication Server DMIS_2011 support package 09</td>
</tr>
<tr>
<td>1.6</td>
<td>2015-08-10</td>
<td>Updated with additional information about SAP NetWeaver Business Client</td>
</tr>
<tr>
<td>1.7</td>
<td>2015-12-28</td>
<td>Updates to reflect SAP Landscape Transformation Replication Server DMIS_2011 support package 10</td>
</tr>
<tr>
<td>1.8</td>
<td>2015-06-10</td>
<td>Updates to reflect SAP Landscape Transformation Replication Server DMIS_2011 support package 11</td>
</tr>
</tbody>
</table>
## Table of Contents

1. **Getting Started** ........................................................................................................... 7
   1.1 About this Document ................................................................................................. 7
   1.2 Related Information ................................................................................................. 7
   1.2.1 Planning Information ......................................................................................... 7
   1.2.2 Further Useful Links ......................................................................................... 8
   1.2.3 Related SAP BW Documentation and Guides .................................................. 8
   1.2.4 Related SAP Landscape Transformation Replication Server Guides ............... 9
   1.3 Key Terms ................................................................................................................ 9
   1.4 Important SAP Notes ............................................................................................. 11

2. **Planning** ..................................................................................................................... 13
   2.1 Introduction ............................................................................................................. 13
   2.2 Installation of SAP Landscape Transformation Replication Server on a Separate System ........................................................................................................ 15
   2.3 Comparison of Different Installation Options ....................................................... 16
   2.4 Compatibility Regarding SP Levels ....................................................................... 17

3. **Source System Preparation and Installation** ............................................................ 18
   3.1 Preparatory Steps for Source System ...................................................................... 18
   3.2 Installation Steps for Source System ....................................................................... 19

4. **SAP LT Replication Server System Preparation and Installation** ............................ 20
   4.1 Preparatory Steps for SAP LT Replication Server System ...................................... 20
   4.2 Installation Steps for SAP LT Replication Server System ....................................... 21

5. **SAP BW System Preparation and Installation** .......................................................... 23
   5.1 Preparatory Steps for SAP BW System ................................................................... 23
   5.2 Installation Steps for SAP BW System ................................................................... 24

6. **Post Installation Activities** ........................................................................................ 25
   6.1 Activation of Web Dynpro and Relevant Services .................................................. 25
   6.2 User Creation and Connections for SAP Source System and SAP BW System .... 26
   6.3 User Creation for SAP LT Replication Server System .......................................... 27
   6.4 User Creation and Connection for non-SAP Source Systems .............................. 28
   6.5 Separate Tablespace for Logging Tables .................................................................. 28
   6.5.1 Creating a Configuration ................................................................................... 28
   6.5.2 Web Service Creation in SAP BW System ....................................................... 31
   6.5.3 Additional Information for Non-SAP Source Systems ...................................... 32
   6.5.4 Data Provisioning ............................................................................................ 32
   6.5.5 Monitoring ......................................................................................................... 33
   6.5.6 Accessing the Configuration and Monitoring Dashboard ............................... 33
   6.5.7 Using the Monitoring Transaction LTRO .......................................................... 35

7. **References** ................................................................................................................. 37
   7.1 List of Documents .................................................................................................... 37
7.2 List of SAP Notes ................................................................. 37
7.3 SAP Help Portal Documentation ............................................. 38
1 Getting Started

1.1 About this Document

Purpose

This guide details the installation and configuration the SAP Landscape Transformation Replication Server in order to facilitate trigger-based replication of data to SAP BW.

This guide is intended for system administrators and consultants performing and initial install and configuration of SAP LT Replication Server. Proficiency with SAP NetWeaver Basis is required to complete the installation.

This guide will take you through the required steps to:
- Decide on a suitable installation type based on the existing system landscape
- Install SAP Landscape Transformation Replication Server
- Configure the source data system for RFC access from the SAP LT Replication Server
- Configure your target system for access by SAP Landscape Transformation Replication Server
- Setup the replication using the SAP LT Replication Server Cockpit
- Start replication from the source system to the target system

1.2 Related Information

1.2.1 Planning Information

For more information about planning topics not covered in this guide, see the following content:

<table>
<thead>
<tr>
<th>Content</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latest versions of installation and upgrade guides</td>
<td><a href="http://service.sap.com/instguides">http://service.sap.com/instguides</a></td>
</tr>
<tr>
<td>Sizing, calculation of hardware requirements - such as CPU, disk and memory resource - with the Quick Sizer</td>
<td><a href="http://service.sap.com/quicksizer">http://service.sap.com/quicksizer</a></td>
</tr>
</tbody>
</table>
### 1.2.2 Further Useful Links

The following table lists further useful links on SAP Service Marketplace:

<table>
<thead>
<tr>
<th>Content</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information about creating error messages</td>
<td><a href="http://support.sap.com/incident">http://support.sap.com/incident</a></td>
</tr>
<tr>
<td>SAP Notes search</td>
<td><a href="http://support.sap.com/notes">http://support.sap.com/notes</a></td>
</tr>
<tr>
<td>SAP Software Distribution Center (software download and ordering of software)</td>
<td><a href="http://support.sap.com/swdc">http://support.sap.com/swdc</a></td>
</tr>
<tr>
<td>SAP Online Knowledge Products (OKPs) – role-specific Learning Maps</td>
<td><a href="http://service.sap.com/rkt">http://service.sap.com/rkt</a></td>
</tr>
</tbody>
</table>

### 1.2.3 Related SAP BW Documentation and Guides

For more information about SAP NetWeaver Business Warehouse landscape, security, installation and administration, see the resources listed in the table below.
1.2.4 Related SAP Landscape Transformation Replication Server Guides

For information about additional SAP Landscape Transformation Replication Server guides and resources, see SAP Note 1972533 (the central SAP Note for SLT replication to SAP BW)

1.3 Key Terms

The following table contains key terms related to SAP Landscape Transformation Replication Server:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>The definition of the parameters that the SAP LT Replication Server uses to replicate data from one or more source systems to one or more target systems. The configuration specifies the source system, the target system, and the relevant connections.</td>
</tr>
<tr>
<td>Configuration and Monitoring Dashboard</td>
<td>An application that runs on the SAP LT Replication Server that you use to specify configuration information (such as the</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>source and target systems, and relevant connections) so that data can be replicated. You can also use it to monitor the replication status.</td>
<td>Database trigger</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>and to pass this data to InfoProviders in the operational DataStore layer at regular short intervals using a daemon. The data is stored in the BW system persistently.</td>
<td>(RDA) Daemon Background process that processes the InfoPackages and data transfer processes assigned to it at regular intervals. The daemon controls and monitors the transfer process for real-time data acquisition.</td>
</tr>
<tr>
<td>Object that describes which data in a DataSource should be requested from a source system.</td>
<td>InfoPackage</td>
</tr>
<tr>
<td>The definition of the parameters that the SAP LT Replication Server uses to replicate data from one or more source systems to one or more target systems. The configuration specifies the source system, the target system, and the relevant connections.</td>
<td>Configuration</td>
</tr>
<tr>
<td>An application that runs on the SAP LT Replication Server that you use to specify configuration information (such as the source and target systems, and relevant connections) so that data can be replicated. You can also use it to monitor the replication status.</td>
<td>Configuration and Monitoring Dashboard</td>
</tr>
</tbody>
</table>

### 1.4 Important SAP Notes

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note, which you can find on SAP Service Marketplace at [http://service.sap.com/notes](http://service.sap.com/notes).

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>19466</td>
<td>Downloading SAP Kernel patches</td>
<td>Downloading a kernel patch in the Service Marketplace, Software Distribution Center.</td>
</tr>
<tr>
<td>517484</td>
<td>Inactive services in the Internet Communication Framework</td>
<td>The Internet Communication Framework Services are inactive when you install the SAP Web Application Server.</td>
</tr>
<tr>
<td>1972533</td>
<td>SLT Replication for SAP BW (PSA) DMIS 2011 SP6</td>
<td>Central SAP Note for SLT replication to SAP BW.</td>
</tr>
<tr>
<td>2325520</td>
<td>Installation/Upgrade SLT - DMIS 2011 SP11</td>
<td>This SAP Note describes the installation or upgrade of SAP LT Replication Server to the...</td>
</tr>
<tr>
<td>SAP Note Number</td>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>relevant DMIS SP</td>
<td></td>
</tr>
<tr>
<td>1768805</td>
<td>Collective Note - non-SAP Sources</td>
<td>This SAP Note describes important considerations of the connection with non-SAP source systems.</td>
</tr>
<tr>
<td>1808251</td>
<td>DataSource - Data Transfer using SLT</td>
<td>This SAP Note contains information about APIs that are required in BW in order to transfer data using SAP Landscape Transformation Replication Server.</td>
</tr>
</tbody>
</table>
2 Planning

2.1 Introduction

Using SAP Landscape Transformation Replication Server (SLT) you can provide real-time data for SAP BW. The Web service interface in BW is used to transfer data. SAP Landscape Transformation Replication Server replicates data in a Web service DataSource. Here the data is available for further processing with real-time data acquisition.

With SAP Landscape Transformation Replication Server, you can replicate non-SAP sources, SAP sources and customer-specific tables. The trigger-based replication allows delta processes to be used for tables that do not have any delta enabled fields. For example, you can use delta processes for extractors (DataSources) without delta logic. If you are working with large master data tables without delta logic that are only changed very infrequently, you can significantly reduce the administration effort for frequent full processes by using SLT trigger-based replication as the transfer method.

Two interfaces are available for transferring data using SAP Landscape Transformation Replication Server:

1. Operational Data Provisioning
   Data transfer using operational data provisioning is supported for tables from SAP systems. SAP LT Replication Server provides the operational data provisioning infrastructure with the source tables as delta queues. The data from the delta queue can be replicated in BW as a subscriber.
   If you use operational data provisioning, you can load the data directly into the InfoProviders (bypassing the PSA layer) by using a data transfer process. The ODP infrastructure (with delta queues) takes over important services such as monitoring data requests. In addition, the ODP infrastructure has been prepared to support BW and other subscribers with SAP LT Replication Server data transfer (for example, SAP Data Services).
   For more information, see service.sap.com/instguides → SAP Components → SAP LT Replication Server → Operational Data Provisioning with SAP LT Replication Server.

2. Web Service
   Data transfer using the Web service interface is supported for tables from SAP systems and for tables from non-SAP systems.
   SAP LT Replication Server replicates the data in a Web service DataSource of the BW Persistent Staging Area, where the data is available for further processing.
   If you use the Web service interface, the data can be pulled with infoPackages into SAP BW, where it can be updated using real-time data acquisition.

With the transfer using Web Service, SAP Landscape Transformation Replication Server offers a useful alternative for data transfer to SAP BW in the following cases:
The tables in the source are transparent tables - no pool/cluster tables - without joins or transformation logic.

The DataSources (extractors) are DataSources on simple tables/views that do not provide a delta mechanism and only contain minimal extractor logic.

The following components are used in the technical system landscape:

- **SAP source system**
  The source system tracks database changes by using database triggers. It records information about changes in the logging tables. Read modules (located on the SAP source system) transfer the data from the source system to the SAP Landscape Transformation Replication Server. The relevant data is read from the application tables.

- **Non-SAP source system**
  The non-SAP source system tracks database changes by using database triggers. It records information about changes in the logging tables. Read modules (located at the SAP Landscape Transformation Replication Server) transfer the data from the non-SAP source system to the SAP Landscape Transformation Replication Server. The relevant data is read from the application tables.

- **SAP Landscape Transformation Replication Server System**
  An SAP system that facilitates the replication of data from one or more source systems to one or more target systems. The source systems can be SAP or non-SAP systems.

- **Target System**
  The SAP BW system. The SAP Landscape Transformation Replication Server and the SAP BW system communicate by means of RFC connections.

SAP Landscape Transformation Replication Server can be used to replicate data from SAP sources and non-SAP sources to the target SAP BW system. For SAP sources, SAP Landscape Transformation Replication Server can either be installed within the source system or in a separate SAP system. For non-SAP sources, SAP Landscape Transformation Replication Server must installed on a separate SAP system.

The relevant information required to create the connection between the source system, the SAP Landscape Transformation Replication Server system, and the target system is specified within the SAP Landscape Transformation Replication Server system as a configuration. In the SAP LT Replication Server Cockpit (transaction LTRC), you can define a new configuration.

We recommend that SAP Landscape Transformation Replication Server is installed on a separate system, but before you begin the installation, it is important to understand the various system landscape options available.

If the source system is an SAP system, SAP Landscape Transformation Replication Server can be installed either:
- On the source system
- On an SAP Solution Manager system or on a separate system
- On the SAP BW system.

**Note**

If the source system is not an SAP system, the SAP Landscape Transformation Replication Server system must be a separate system.
SAP Landscape Transformation Replication Server uses background processing to replicate data. This can be an important factor in deciding where to install SAP LT Replication Server since background processing uses CPU cycles. If the SAP LT Replication Server is a separate system, this ensures that the background processes do not run on the source system. This option separates the software maintenance activities (kernel upgrades/patch management and so on) from the source system.

1. **Note**
   - SAP source system can be configured as a source to multiple SAP Landscape Transformation Replication Servers
   - Each SAP Landscape Transformation Replication Server can be configured to more than one SAP BW system.
   - Replication of non-sap sources require that SAP LT Replication Server is installed on a separate system
   - The SAP Landscape Transformation Replication Server system must be a UNICODE system
   - Ensure that database performance is good. Poor database performance can result in poor SAP Landscape Transformation Replication Server performance.

1. **Note**

For more information about transferring data with SAP LT Replication Server, see SAP Library for SAP BW on SAP Help Portal at http://help.sap.com. See section 7.3 for the navigation path.

### 2.2 Installation of SAP Landscape Transformation Replication Server on a Separate System

We recommend that SAP Landscape Transformation Replication Server is installed on a separate system as illustrated below:

![Typical system landscape diagram](image)
Note that the source system could also be a non-SAP system.

If you use a non-SAP source system, ensure that the database of your non-SAP source fulfills all prerequisites for usage with the SAP LT Replication Server. Since a database connection from the SAP LT Replication Server to a non-SAP system is required, the OS/DB restrictions of the underlying SAP NetWeaver (7.02 or higher) apply (see http://service.sap.com/pam).

Note that only the read modules are created in the SAP Landscape Transformation Replication Server (for SAP source systems, the read modules are located in the source system only). The connection from the SAP Landscape Transformation Replication Server system to the non-SAP source system is established by means of a database connection.

For non-SAP source systems, the customer database license needs to cover a permanent database connection with third party products such as SAP Landscape Transformation Replication Server.

2.3 Comparison of Different Installation Options

The following table outlines in detail the advantages and disadvantages of the different installation options:

<table>
<thead>
<tr>
<th></th>
<th>Separate System</th>
<th>BW System</th>
<th>Source System (if SAP)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advantages</td>
<td>• No software maintenance dependencies</td>
<td>• Simplified landscape and administration</td>
<td>• Simplified landscape and administration</td>
</tr>
<tr>
<td></td>
<td>• Flexibility</td>
<td>• Re-use of existing NW instance</td>
<td>• Re-use of existing SAP ERP instance</td>
</tr>
<tr>
<td>Disadvantages</td>
<td>• Investment and maintenance effort for separate server / NW instance</td>
<td>• Performance impact</td>
<td>• Performance impact</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Potential software maintenance dependencies</td>
<td>• Potential software maintenance dependencies</td>
</tr>
</tbody>
</table>

Experiences show that BW customers using SAP Landscape Transformation Replication Server tend to use a dedicated SAP Landscape Transformation Replication Server system for productive use. An SAP Landscape Transformation Replication Server sandbox or quality assurance system is installed sometimes on top of an appropriate SAP source system or on top of an SAP Solution Manager system.
2.4 Compatibility Regarding SP Levels

The table below outlines the compatibility between the different SP levels of the source system, the SAP Landscape Transformation Replication Server, and the SAP BW system.

<table>
<thead>
<tr>
<th>Source System</th>
<th>SAP Landscape Transformation Replication Server</th>
<th>SAP NW BW Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMIS 2011 SP02-11</td>
<td>DMIS 2011 SP11</td>
<td>SAP BW 7.0 – BW 7.5 (BW on HANA)</td>
</tr>
<tr>
<td>DMIS 2010 SP7-10</td>
<td>DMIS 2010 SP10</td>
<td>SAP BW 7.0 – BW 7.3</td>
</tr>
</tbody>
</table>

Note that you are only able to use all available SAP Landscape Transformation Replication Server features with the highest SP /SPS level. For more information, see SAP Note 1972533 - SAP LT Replication for SAP BW (PSA).
3 Source System Preparation and Installation

Note
This chapter is not relevant if your source system is a non-SAP system.

3.1 Preparatory Steps for Source System

Overview

Use this section to check that the source system is suitable for the replication of data using SAP LT Replication Server. Note that the SAP Landscape Transformation Replication Server is shipped in a specific add-on (DMIS_2011* or DMIS_2010*).

If you intend to run SAP Landscape Transformation Replication Server on your source system, the details outlined in section 4.2, Installation Preparatory Steps for SAP Landscape Transformation Replication Server System also apply. Note that more than one source systems can participate in a replication project, depending on your business requirements.

Overview of Required Components

- The DMIS Add-on, DMIS_2011 with a minimum support package 02

Note
For SAP R/3 4.6C source systems, or if other DMIS_2010-based applications are in use, it is sufficient to install DMIS_2010 (this add-on contains SAP Landscape Transformation Replication Server 1.0).

System Requirements

The following conditions apply for the source system:
- The system must be of at least SAP Basis release 4.6C
To check whether your system is suitable for the installation of the DMIS add-on, DMIS_2011, proceed as follows:

1. Determine the SAP Basis version of your source system (choose System → Status, and choose the Other Kernel Info pushbutton)
2. SAP Note 1577441 and SAP Note 1577503 contain information about the installation and upgrade to DMIS 2011. Refer to these SAP Notes in order to determine that your SAP Basis and support package versions are supported.

### 3.2 Installation Steps for Source System

Use this section to install the required DMIS component in your source system.

**Note**

If you plan to run SAP Landscape Transformation Replication Server on the source system, you only have to follow the procedure that is described in chapter 4, SAP LT Replication Server Preparation and Installation.

All required software components are available from the SAP Software Download Center https://support.sap.com/swdc and can be installed with the SAP Add-On Installation Tool (SAINT). For more information about SAINT, see [here](#).

If your source system is a non-SAP system, you do not have to follow the procedure described below for the source system. The installation of the DMIS add-on is not required (or possible) on non-SAP source systems.

To install the DMIS Add-on, DMIS_2011 with SP02 or higher, proceed as follows:

1. Navigate to the SAP Software Download Center, [https://support.sap.com/swdc](https://support.sap.com/swdc)
2. Download the relevant DMIS version from the following path:
   
   
   Installations and Upgrades → A-Z Index → L → SAP LT Replication Server → SAP LT Replication Server 2.0

   **Note**

   If you want to use DMIS_2010, then choose SAP LT Replication Server 1.0.

3. Follow the DMIS installation procedure as described in SAP Note 1577441. For information, see SAP Note 1972533.
4. Download latest available support packages from the following path:

   Support Packages and Patches → A-Z Index → L → SAP LT Replication Server → SAP LT Replication Server 2.0

5. Choose **Entry by Component**, and select the relevant product component version.

   **Note**

   If you want to use DMIS_2010, then choose SAP LT Replication Server 1.0.
4 SAP LT Replication Server System Preparation and Installation

4.1 Preparatory Steps for SAP LT Replication Server System

Use this section to check that the SAP LT Replication Server system is suitable for the replication of data using SAP LT Replication Server. Note that the SAP LT Replication Server is shipped in a specific add-on (DMIS_2011* or DMIS_2010*).

Note
We recommend that the SAP LT Replication Server System is a separate system.

Overview of Required Components

- The DMIS Add-on, DMIS_2011_1_700 SP11 (minimum required version is SP5).

Note
If other DMIS_2010 based applications (such as TDMS 3.0) are in use in the SAP Landscape Transformation Replication Server system, it is sufficient to install the add-on DMIS_2010_1_700 SP09.

System Requirements

The following requirements apply for the SAP LT Replication Server system:

- The system must be an SAP system with minimum SAP NetWeaver release of 7.02 (with at least Basis support package 8) ABAP stack

Note
You can download SAP NetWeaver 7.00 with EHP 2.0 from the SAP Software Download Center at http://service.sap.com/swdc. For more information, see the Master Guide for SAP NetWeaver 7.00.

- File system: 100 GB
- RAM: 16-32 GB
- CPU: 2-4 cores
• Minimum number of background jobs: 10

To check whether your system is suitable for the installation of the DMIS add-on, DMIS_2011, proceed as follows:

1. Determine the SAP Basis version of your SAP LT Replication Server system (choose System → Status, and choose the Other Kernel Info pushbutton)
2. SAP Note 1577441 and SAP Note 1577503 contain information about the installation and upgrade to DMIS 2011. Refer to these SAP Notes in order to determine that your SAP Basis and support package versions are supported.

Note
For more information about possible DMIS versions, see SAP Note 1691975.

4.2 Installation Steps for SAP LT Replication Server System

Use this section to install the required DMIS component in your SAP Landscape Transformation Replication Server system.

All required software components are available from the SAP Software Download Center https://support.sap.com/swdc and can be installed with the SAP Add-On Installation Tool (SAINT). For more information about SAINT, see here.

To install the DMIS add-on, DMIS_2011 SP11, proceed as follows:

1. Navigate to the SAP Software Download Center, https://support.sap.com/swdc
2. Download the relevant DMIS version from the following path:
   
   Installations and Upgrades → A-Z Index → L → SAP LT Replication Server → SAP LT Replication Server 2.0

   Note
   If you want to use DMIS_2010, then choose SAP LT Replication Server 1.0.

3. Follow the DMIS installation procedure as described in SAP Note 1577441. For information, see SAP Note 1972533.

4. Download latest available support packages from the following path:
5. Choose *Entry by Component*, and select the relevant product component version.

*Note*

If you want to use DMIS_2010, then choose *SAP LT Replication Server 1.0*. 
5  SAP BW System Preparation and Installation

5.1  Preparatory Steps for SAP BW System

Use this section to check that the SAP BW system is suitable for the replication of data using SAP LT Replication Server.

Prerequisites

You have implemented SAP Note 1808251 in the SAP BW system.

Overview of Required Components

- The DMIS Add-on, DMIS_2011 SP11 (minimum support package is SP02).

System Requirements

The following requirements apply for the SAP BW system:

- For SAP BW 7.0, the minimum SP level is SP17.
- For SAP BW 7.01 and 7.40, the minimum SP level is SP00.
- For SAP BW 7.02 to 7.31, the minimum SP level is SP01.

To check whether your system is suitable for the installation of the DMIS add-on, DMIS_2011, proceed as follows:

1. Determine the SAP Basis version of your source system (choose System → Status, and choose the Other Kernel Info pushbutton)
2. SAP Note 1577441 and SAP Note 1577503 contain information about the installation and upgrade to DMIS 2011. Refer to these SAP Notes in order to determine that your SAP Basis and support package versions are supported.
5.2 Installation Steps for SAP BW System

Use this section to install the required DMIS component in your SAP BW system.

All required software components are available from the SAP Software Download Center https://support.sap.com/swdc and can be installed with the SAP Add-On Installation Tool (SAINT). For more information about SAINT, see here.

To install the DMIS add-on, proceed as follows:

1. Navigate to the SAP Software Download Center, https://support.sap.com/swdc
2. Download the relevant DMIS version from the following path:
   \textit{Installations and Upgrades} → \textit{A-Z Index} → L → SAP LT Replication Server → SAP LT Replication Server 2.0
   \begin{itemize}
   \item \textbf{Note}
   \end{itemize}
   \begin{itemize}
   \item If you want to use DMIS_2010, then choose \textit{SAP LT Replication Server 1.0}.
   \end{itemize}
3. Follow the DMIS installation procedure as described in SAP Note 1577441.
4. Download latest available support packages from the following path:
   \textit{Support Packages and Patches} → \textit{A-Z Index} → L → SAP LT Replication Server → SAP LT Replication Server 2.0
5. Choose \textit{Entry by Component}, and select the relevant product component version.
6 Post Installation Activities

6.1 Activation of Web Dynpro and Relevant Services

After the installation of SAP LT Replication Server, all required Web Dynpro SAP LT Replication Server services are initially disabled. You must enable these services in order to run the SAP LT Replication Server user interface.

To activate the SAP LT Replication Server services, proceed as follows:

1. Activate Web Dynpro services as described here: Active Services in SICF
2. Run transaction SICF.
3. In the Hierarchy Type field, enter SERVICE, and choose Run.
4. Expand the node default_host, and navigate to sap → bc → webdynpro → sap
5. Activate the following services:
   - iuuc_replication_config
   - iuuc_repl_mon_powl
   - iuuc_helpcenter
   - iuuc_helpcenter_document
   - iuuc_repl_wdc_config_gaf
   - iuuc_repl_mon_schema_oif
   - /sap/public/bc
   - /sap/public/bc/ur
   - /sap/public/myssocntl
   - /sap/bc/webdynpro/sap/iuuc_repl_mon_schema_oif
   - /sap/public/bc/icons
   - /sap/public/bc/icons_rtl
   - /sap/public/bc/webicons
   - /sap/public/bc/pictograms
   - /sap/public/bc/webdynpro
   - /sap/public/bc/webdynpro/adobeChallenge
   - /sap/public/bc/webdynpro/mimes
   - /sap/public/bc/webdynpro/ssr
   - /sap/public/bc/webdynpro/ViewDesigner
   - /sap/bc/nwbc

We also recommend using SSL to protect the network communications. This requires the configuration of the underlying SAP NetWeaver ABAP Server for the HTTPS protocol, and that the security settings are set to ‘SSL’ for the above listed ICF services.
6.2 User Creation and Connections for SAP Source System and SAP BW System

In order to replicate data using the SAP LT Replication Server, you must create an RFC connection to the source system and to the target SAP BW system.

In order to do this, the following roles are required:

- SAP_IUUC_REPL_REMOTE
- SAP_IUUC_REPL_REMOTE_BW

Note

If you use a new client after the DMIS add-on is applied, you must transport the necessary roles from client 000 into your target client.

Note

For more details about the roles and authorization concept of SAP LT Replication Server, see the Security Guide for SAP LT Replication Server.

Prerequisites

Refer to the SAP user administration guide for RFC user creation.

Generating Role SAP_IUUC_REPL_REMOTE and SAP_IUUC_REPL_REMOTE_BW

To generate the role SAP_IUUC_REPL_REMOTE, proceed as follows:

1. Execute transaction PFCG.
2. In the role field, enter the role SAP_IUUC_REPL_REMOTE.
3. Choose the Change Role pushbutton.
5. The system displays the Change Role: Authorizations screen. Choose the Generate pushbutton.
6. Return to the Authorizations tab page; this tab page should now have a green light.
7. In the User tab page, choose the User Comparison pushbutton.
8. The system displays the Compare Role User Master Record screen. Choose the Complete Comparison pushbutton.
9. The User tab page should now also have a green light. Perform the same steps for role SAP_IUUC_REPL_REMOTE_BW

Creating Users and RFC Connections

Create the required user and RFC connection as follows:

1. Create a user (of type Dialog or System) in your source system, generate and assign the following role to this user:
   - SAP_IUUC_REPL_REMOTE

   **Note**
   Do not use user DDIC. The role SAP_IUUC_REPL_REMOTE is not generated by default. You must generate and assign this role to the newly created user

2. Create an RFC connection (type 3 – ABAP) from the SAP LT Replication Server to the source system with the newly created user (if both systems are Unicode, specify the RFC connection as Unicode).

   **Note**
   If the source system and the SAP LT Replication Server are the same system, create an RFC connection and do not use the RFC connection NONE.

3. Create a user (of type Dialog or System) in your target BW system, generate and assign the following role to this user:
   - SAP_IUUC_REPL_REMOTE_BW

4. Create an RFC connection (type 3 – ABAP) from the SAP LT Replication Server to the target system with the newly created user

6.3 User Creation for SAP LT Replication Server System

SAP Landscape Transformation Replication Server is delivered with an own role SAP_IUUC_REPL_ADMIN. To activate the role, follow the procedure described in 6.2.

For more details about the roles and authorization concept of SAP Landscape Transformation Replication Server, see the Security Guide for SAP Landscape Transformation Replication Server.
6.4 User Creation and Connection for non-SAP Source Systems

If you want to replicate data from a non-SAP source system, you have to create a secondary database connection. To establish a secondary database connection from an SAP system to an external database, the connection data and the user data of a user are required. This user must be authorized to establish a connection to the external database. The SAP system connects to a specific schema from the database. To perform the replication and initially load a specific table from a given schema, the database user must have privileges for the following actions:

- Selecting from the table
- Creating a table in the given schema (for creating the logging table)
- Selecting from the logging table
- Deleting the logging table
- Creating database triggers for the table
- Deleting the triggers
- Creating synonyms for the specific table
- Deleting the synonyms

Depending on the specific external database system, the process of granting privileges to a user can vary.

6.5 Separate Tablespace for Logging Tables

It is possible (but not essential) to store the source system replication log tables in a separate table space. The decision to do this is the responsibility of the system administrator. One advantage of having the log tables in their own table space is that you can easily monitor the size of the log tables.

As each database system has its own method of providing this functionality, refer to your database documentation for this procedure.

If you use your own data classes and tablespaces, see SAP Note 46272.

Chapter 6.5.1 describes how to make your tablespace known to the configuration in the SAP LT Replication Server.

6.5.1 Creating a Configuration

In the SAP LT Replication Server system, you define a connection between the source system, the SAP LT Replication Server and the target system. You specify this information as a configuration.

To create a configuration, proceed as follows:
Run transaction LTRC. Choose the New pushbutton. Creating a configuration involves the following steps:

Specify General Data

In this step, you specify the following information:

- Configuration Name
  - You must specify a name for the configuration. This name is used for the schema that is created automatically in the target system.
- Description (Optional)
  - You can specify a description for the configuration.
- Authorization Group (Optional)
  - If you have sufficient authorizations, and require specific authorizations for the configuration, you can specify an authorization group here, and use this authorization group in the corresponding authorization object S_DMIS_SLT.

Specify Source System

For SAP source systems, you specify the following information:

- System Data
  - You can use either an SAP system or a non-SAP system as a source system.
- RFC Destination
  - Specify the RFC destination to the source system.
- Allow Multiple Usage
  - Select this checkbox if you want to replicate data from an SAP source system to multiple target systems.
- Read from Single Client
  - Select this checkbox if you only want to replicate data from the client that is specified in the RFC destination.

For non-SAP source systems, you specify the relevant database and connection information.

Specify Target System

For SAP target systems, you specify the following information:

- RFC Destination
  - Specify the RFC destination to the target system.
- Scenario for RFC Communication
  - Choose the following replication scenario:
    - BW PSA Replication Scenario: The BW (Business Warehouse) PSA (Persistent Staging Area) Replication Scenario allows you to connect the SAP LT Replication Server directly to a BW system, therefore
facilitating real-time data replication to SAP BW. The SAP LT Replication Server uses the logical system name that you specify in this step to create new data sources in the BW logical system (of type Web Service) that you have to define after you create the configuration (see section 6.5.2). SAP LT Replication Server connects to the BW system by means of the RFC destination. SAP LT Replication Server will trigger the creation of DataSources with the naming convention SLT_<table_name> in the BW system, and replicate the data to these DataSources. In order to work with the data in SAP BW, contact your SAP BW system administrator.

Specify Transfer Settings

In this step, you specify the following information:

- Initial Load Mode
  - There are different options (reading types) available for the initial load. These reading types access the data in the source system table in different ways. In order to accelerate the initial load, you can change the data load behavior for the entire configuration. The default setting is Resource Optimized (reading type 3 for all tables), but you can accelerate the data load by choosing Performance Optimized (reading type 5 for transparent tables, and reading type 4 for cluster tables).

Information about Reading Types:

  - Reading Type 3 - DB_SETGET

The reading type DB_SETGET is the default reading type. It uses a function to read the records of the source table ordered by the primary key. This means that no additional index is required as the primary index is used. The function returns a set of table records (the default is 10,000 records).

  - Reading Type 4 and 5 - Index Cluster

Data is read from the source table and stored in a cluster-like table (DMC_INDXCL) in the source system. All rows are read from the source table, divided into portions and compressed in a raw format. Because data is extracted to a separate table in the source system, additional temporary tablespace is required for table DMC_INDXCL (approximately 10% of the source table size for transparent tables and between 50% to 75% of the source table size for cluster tables). Reading type 5 is the same as reading type 4, but uses a full table scan to read the data. (the preferred method for reading data from transparent tables).

- Dataclass of Tablespace
  - You can specify a tablespace for the logging tables in the source system.

- No. of Data Transfer Jobs
  - You can specify the number of jobs that are used for the data transfer process in the SAP LT Replication Server. This value specifies the number of data transfer jobs which will run in the SAP LT Replication Server to replicate the tables of the RFC connection to the target system. For more information, see the Application Operations Guide (note that this guide details specifics for SAP LT Replication Server for SAP HANA, but the principles described here with regard to data transfer jobs are valid for the BW context).

- No. of Initial Load Jobs

Post Installation Activities

Trigger-Based Data Replication Using SAP Landscape Transformation Replication Server
You can specify the number of jobs that are used for the initial load in the SAP LT Replication Server.

- **No. of Calculation Jobs**
  - For reading types 1 and 3, this is the number of jobs that are used to calculate the data transfer portions that are used for the initial load. For reading types 4 and 5, it is the number of jobs that transfer the portions to table DMC_INDXCL.

- **Replication Options**

  You can choose one of the following replication options:
  - **Real-time** - The trigger-based data replication method that continuously replicates any data changes to the target system.
  - **Schedule by Interval** - You can specify a time and frequency for the replication. For example, every 30 minutes or every 12 hours.
  - **Schedule by Time** - You can specify a specific time for the replication, for example 23:00. The SAP LT Replication Server would then replicate any database changes to the target system every day at 23:00.

Application (Optional)

Depending on your use case, you may be required to specify an application.

**Review and Create**

In this step, you can review your settings and create the configuration.

**Check or Maintain Configuration Scenario Parameter**

Check if your scenario is correctly specified as PSA scenario in table IUUC_REPL_CONFIG. If not, enter the value **PSA** for the parameter **trg_scenario** for the configuration (MT_ID). You can do this in transaction **SE16**.

### 6.5.2 Web Service Creation in SAP BW System

In the SAP BW system, you have to create a Web service for each source system to ensure that source tables and source DataSources with the same name coming from different source systems are loaded into separate Web service DataSources.

In order to do this, proceed as follows:

1. Open the Data Warehousing Workbench (transaction **RSA1**) and select **Source Systems**.
2. In the source systems list, open the context menu on the **WebService** folder and choose **Create**.
3. Enter the **Logical System Name** and the **Source System Name**.
6.5.3 Additional Information for Non-SAP Source Systems

If you are replicating from a non-SAP source systems, the user you specify needs the authorizations as described in SAP LT Replication Server – Security Guide.

The actual privilege to be granted to the database user depends on the database system (Oracle, DB2, MSSQL and so on). For example, if you want to configure an Oracle database as a non-SAP source system, the following steps apply:

1. Install the Oracle instant client on the SAP LT Replication Server (if your SAP LT Replication Server is not based on Oracle).
2. Install the DBSL database dependent library for the 7.20 Kernel.
3. Create the database connection in table DBCON (by using transaction SM30)
4. Add the database connection in transaction DBACOCKPIT
5. Test the database connection
6. In the SAP LT Replication Server, use transaction LTRC to complete the configuration for the non-SAP source system.

**Constraints**

Only tables with a primary key can be replicated.

**Note**

For important considerations about non-SAP source systems, see SAP Note 1768805.

6.5.4 Data Provisioning

You use the SAP LT Replication Server Cockpit (transaction LTRC) to control the replication process for the SAP LT Replication Server.

You can control the replication process as follows:

1. Launch SAP LT Replication Server Cockpit by using transaction LTRC. Choose the Data Provisioning pushbutton.
2. You can use the following radio buttons to control the replication for the selected source system:
   - **Start Load**
Starts and initial load of replication data from the source system. The replication is a onetime event, and after completion, further changes to the source system database will not be replicated.

- **Start Replication**
  Starts an initial load procedure and then begins the continuous or scheduled replication procedure.

- **Stop Load / Replication**
  Stops any current load or replication processes.

- **Suspend Replication**
  Pause a table from a running replication. The trigger will not be deleted from the source system. The delta will still be stored in log tables in the source system.

- **Resume Replication**
  Restart replication for a suspended table. Previous suspended replication will be resumed (no new initial load required).

You can access the created data sources and replicated data in the SAP BW system by using transaction RSA1 (Administrator Workbench).

**Note**

It is only possible to replicate transparent tables. It is not possible to replicate pool tables or cluster tables. For more information, see SAP Note 1908836.

### 6.5.5 Monitoring

You use the SAP LT Replication Server Cockpit (transaction LTRC) to monitor the replication process for the SAP LT Replication Server. You can use the SAP LT Replication Server Cockpit to get detailed monitoring information for a single configuration. For more information, see the documentation for the SAP LT Replication Server Cockpit (directly accessible from the UI of the SAP LT Replication Server Cockpit).

Note that to view monitoring information for multiple configurations simultaneously, you can use the monitoring transaction LTRO (see section 6.5.7).

### 6.5.6 Accessing the Configuration and Monitoring Dashboard

You can use the Configuration and Monitoring Dashboard to view status information for the replication.

You can access the Configuration and Monitoring Dashboard by using transaction LTR. For a configuration, the system displays target system ID, the source system ID, the mass transfer ID, and the status of the configuration.

In addition, the system displays the following tabs:
<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jobs and Connections</td>
<td>On this tab, you can view the status of the configuration, as well as information about the data transfer jobs. For a configuration, you can view the technical name of the connection to the source system, and the status of the connection. You can also view information about the connection to the target system.</td>
</tr>
<tr>
<td>Triggers</td>
<td>A database trigger is a piece of code that updates a database automatically in response to a certain event. On this tab, you can view the tables for which triggers are created, as well as status information for the triggers.</td>
</tr>
<tr>
<td>Statistics</td>
<td>On this tab, you can view statistical information for individual tables, for example the current action for a table, and latency information.</td>
</tr>
<tr>
<td>Settings</td>
<td>The Settings tab contains the following sections:</td>
</tr>
<tr>
<td></td>
<td>• General Data</td>
</tr>
<tr>
<td></td>
<td>You can view the short description for the configuration, and specify an authorization group if required.</td>
</tr>
<tr>
<td></td>
<td>• Transfer Settings</td>
</tr>
<tr>
<td></td>
<td>You can specify an initial load mode and a data class for the logging tables in the source system if required.</td>
</tr>
<tr>
<td></td>
<td>• Job Options</td>
</tr>
<tr>
<td></td>
<td>You can adjust the number of data transfer jobs, initial load jobs, and calculation jobs.</td>
</tr>
<tr>
<td></td>
<td>• Replication Options</td>
</tr>
<tr>
<td></td>
<td>You can specify a replication option, for example you can choose to replicate data in real-time, or you can specify an interval for the replication. In addition, you can activate replication logging. If you choose this option, the replicated data entries will be saved in the SAP Landscape Transformation Replication Server system for all tables in the configuration. This means if any data is missing from the target system, you can view this data and replicate it again from the SAP Landscape Transformation Replication Server system to the target system. To use this option, select the Activate Replication Logging checkbox. Note that you can activate replication logging for specific tables using transaction LTRS (Advanced Replication Settings).</td>
</tr>
</tbody>
</table>
Note

In order to ensure compliance with security standards, the Configuration and Monitoring Dashboard (transaction LTR) requires the use of the SAP NetWeaver Business Client 3.5 or 4.0. The reason for this is that the SAP NetWeaver Business Client supports a logout for all Web Dynpro windows. Web browsers do not support this logout feature. For example, if you use a web browser to access the work center, there is no option to logout. Simply closing the web browser window does not log the user out of the system. The session runs on the server until it times out, and this is a potential security risk.

In order to use the SAP NetWeaver Business Client, the relevant user must have the role SAP_IUUC_REPL_NWBC assigned to them.

Note that you can also use the SAP LT Replication Server Cockpit (transaction LTRC) in order to work with configurations.

6.5.7 Using the Monitoring Transaction LTRO

6.5.7.1 Overview

The monitoring transaction, LTRO, is a tool which runs on the SAP LT Replication Server system and can assist system administrators with obtaining a faster overview about the participating systems and configurations. For example, you can use the monitoring transaction to get information about:

- The number of current running and free batch and dialog processes running on all application servers of the SAP Landscape Transformation Replication Server system
- The availability status for all connected target systems, and the corresponding log entries (warnings and errors)
- The status of multiple configurations (mass transfer IDs) within a single screen

Even though you can use the SAP LT Replication Server Cockpit (transaction LTRC) to view the status of a single configuration, system administrators managing multiple configurations have to switch from configuration to configuration in order to see the relevant status. The benefit of using the monitoring transaction is to have all relevant information in one screen.
6.5.7.2  Overview Tab Page

The Overview tab page is divided into two sections. The section on the left hand side contains SAP LT Replication Server system-specific information, and the right hand side you can view details about all connected systems.

On the left hand side, under Details, you can view the available application servers for the SAP LT Replication Server system. For each application server, you can view the number of free and available processes, and the maximum runtime (longest running process in seconds) for the processes (in seconds). The number of free process is an indicator for the load on the SAP LT Replication Server system. If a high maximum runtime value occurs, this could indicate an issue with a long running process.

At the top of the tab page, you can view aggregated values for the application servers. This is the total number of free and available processes, and the highest maximum runtime value (the longest running process across all application servers).

On the right hand side, you can view all the target systems that are connected to the SAP LT Replication Server system. For each target system, you can view the target system status (a connection status), as well as the configurations assigned to the target system. Under Target Alerts, the system displays up to 20 database log entries for the last 12 hours. You can customize these settings in table IUUC_RM_PARAMS (field PARAM, value RCVR_ALERTS_INT for the time period, and value RCVR_ALERTS_NO for the maximum number of database log entries to be displayed).

6.5.7.3  Configuration View Tab Page

In the Configuration View tab page, you can view the status of the master job, and an overview of all configurations selected when the transaction was executed.

For each configuration, you can view information such as the name, status, technical ID, and so on.

The advantage of this view is that system administrators can see multiple configurations on a single screen without needing to switch from one configuration to another.

You can navigate to the details of an individual configuration by clicking an entry in the Mass Transfer ID field or by choosing the Open Tables View pushbutton. To view additional information for the configuration, you can navigate to the SAP LT Replication Server Cockpit (transaction LTRC) and use the tab pages Table Overview, Data Transfer Monitor, and Application Logs.
7 References

7.1 List of Documents

The following table lists all documents mentioned in this Master Guide.

<table>
<thead>
<tr>
<th>Title</th>
<th>Where to Find</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Security Guide: Trigger-Based Data Replication Using SAP Landscape Transformation Replication Server for SAP HANA Appliance Software)</td>
<td></td>
</tr>
<tr>
<td>(Operations Guide: Trigger-Based Data Replication Using SAP Landscape Transformation Replication Server for SAP HANA Appliance Software)</td>
<td></td>
</tr>
</tbody>
</table>

7.2 List of SAP Notes

The following table lists all SAP Notes mentioned in this Master Guide.

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>19466</td>
<td>Downloading SAP Kernel patches</td>
<td>Downloading a kernel patch in the Software Distribution Center.</td>
</tr>
<tr>
<td>517484</td>
<td>Inactive services in the Internet Communication Framework</td>
<td>The Internet Communication Framework Services are inactive when you install the SAP Web Application Server.</td>
</tr>
<tr>
<td>1972533</td>
<td>SLT Replication for SAP BW (PSA)</td>
<td>Central SAP Note for SLT replication to SAP BW.</td>
</tr>
<tr>
<td>2191214</td>
<td>Installation/Upgrade SLT - DMIS 2011</td>
<td>This SAP Note describes the installation or upgrade of SAP LT Replication Server to the relevant DMIS SP.</td>
</tr>
</tbody>
</table>
## References

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1768805</td>
<td>Collective Note - non-SAP Sources</td>
<td>This SAP Note describes important considerations of the connection with non-SAP source systems.</td>
</tr>
<tr>
<td>1808251</td>
<td>DataSource - Data Transfer using SLT</td>
<td>This SAP Note contains information about APIs that are required in BW in order to transfer data using SAP Landscape Transformation Replication Server.</td>
</tr>
<tr>
<td>2325520</td>
<td>Installation/Upgrade SLT - DMIS 2011 SP11</td>
<td>This SAP Note describes the installation or upgrade of SAP LT Replication Server to the relevant DMIS SP.</td>
</tr>
<tr>
<td>1577503</td>
<td>Upgrade to DMIS 2011_1 in the System Switch Upgrade</td>
<td>This SAP Note contains information about upgrading to DMIS_2011.</td>
</tr>
<tr>
<td>1691975</td>
<td>HANA LTR - Clarification on DMIS releases</td>
<td>This SAP Note contains information about DMIS release levels.</td>
</tr>
</tbody>
</table>

### 7.3 SAP Help Portal Documentation

For more information about transferring data with SAP Landscape Transformation Replication Server, see SAP Library for SAP BW on SAP Help Portal at http://help.sap.com under → Technology Platform → SAP NetWeaver → SAP NetWeaver Platform → <Choose the Relevant Release>:

- **SAP NetWeaver 7.5** → Application Help → Function-Oriented View → <Your Language> → SAP NetWeaver Library: Function-Oriented View → SAP Business Warehouse → Data Warehousing → Modeling → Data Acquisition Layer → Data Provision Using Source Systems → Transferring Data with SAP Landscape Transformation Replication Server
- **SAP NetWeaver 7.4** → Application Help → Function-Oriented View → <Your Language> → SAP NetWeaver Library: Function-Oriented View → SAP Business Warehouse → Data Warehousing → Modeling → Data Acquisition Layer → Data Provision Using Source Systems → Transferring Data with SAP Landscape Transformation Replication Server
- **SAP NetWeaver 7.3 - Including Enhancement Package 1** → Application Help → Function-Oriented View → <Your Language> → SAP NetWeaver Library: Function-Oriented View → Business Warehouse → Data Warehousing → Modeling → Data Acquisition → Transferring Data with SAP Landscape Transformation Replication Server
- **SAP NetWeaver 7.3** → Application Help → Function-Oriented View → <Your Language> → SAP NetWeaver Library: Function-Oriented View → Business Warehouse → Data Warehousing → Modeling → Data Acquisition → Transferring Data with SAP Landscape Transformation Replication Server
• SAP NetWeaver 7.0 - Including Enhancement Package 3 → Application Help → Function-Oriented View → <Your Language> → SAP NetWeaver by Key Capability → Information Integration by Key Capability → Business Intelligence → Data Warehousing → Modeling → Data Acquisition → Transferring Data with SAP Landscape Transformation Replication Server

• SAP NetWeaver 7.0 - Including Enhancement Package 2 → Application Help → Function-Oriented View → <Your Language> → SAP NetWeaver by Key Capability → Information Integration by Key Capability → Business Intelligence → Data Warehousing Data Staging → Transferring Data with SAP Landscape Transformation Replication Server

• SAP NetWeaver 7.0 - Including Enhancement Package 1 → Application Help → Function-Oriented View → <Your Language> → SAP NetWeaver by Key Capability → Information Integration by Key Capability → Business Intelligence → Data Warehousing → Data Acquisition → Transferring Data with SAP Landscape Transformation Replication Server

• SAP NetWeaver 7.0 → Application Help → Function-Oriented View <Your Language> → SAP NetWeaver by Key Capability → Information Integration: Key Areas → Business Intelligence → Data Warehousing → Data Acquisition → Transferring Data with SAP Landscape Transformation Replication Server
Material Number

© 2016 SAP AG or an SAP affiliate company. All rights reserved. No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice. Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors. National product specifications may vary. These materials are provided by SAP AG and its affiliated companies (“SAP Group”) for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty. SAP and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and other countries. Please see www.sap.com/corporate-en/legal/copyright/index.epx#trademark for additional trademark information and notices.